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Service Technologies Corporation makes no representations or warranties with respect to the contents of this guide and disclaims any implied warranties 
of fitness for any particular purpose.  We reserve the right to revise this publication.  No part of this publication may be reproduced in any form without the 
prior written consent of Service Technologies Corporation. 
Trademark Acknowledgments:  Platinum for DOS® is a registered trademark of E Software Corporation. Pay-Ware is a registered trademark of Service 
Technologies Corp.   Platinum is a registered trademark of Platinum Technologies Int’l Inc.  & Best Software Corp.  All other trademarks are acknowledged. 
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Contact Information on Service Technologies Corp. 
 
We value our customer relationships and take pride in being a responsive Software Developer.  
Since we never stop refining our products, our user partners (you) are a key source of desired 
new product features as well as occasionally finding the odd “glitch” in our software (there is 
no such thing as a perfect program - ask Bill Gates about Windows 95 ‘er 98 ‘er 98se ‘er 2000). 
 
 
 

 
   We enjoy hearing from you and here’s how you can contact us. 

 
 
 Phone                (336) 768-1787    

         (“Live Bodies” generally available 8AM - 5:30 PM Eastern Mon-Fri) 
  
 
 Fax           (336) 768-1602   

         
 
 E- mail                  support@pay-ware.com 
 

 
 
 
 
Thanks for purchasing a Service Technologies’ Windows Program.  

 
Our Programs have been designed to provide Accounting Users with immediate comfort though 
easy-to-use, familiar Menu Architecture & Processing Logic.  Further, STC Programs come with 
30 days of unlimited support.  So, if after reading the enclosed materials you have additional 
questions, please contact us. 
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IMPORTANT SERVICE TECHNOLOGIES SOFTWARE LICENSE AGREEMENT  - -   
READ CAREFULLY BEFORE OPENING SOFTWARE 

 
 
This is a legal agreement between you (an individual or an entity) the end user, and Service Technologies Corporation (STC).  If 
you do not agree to the terms of this Agreement, promptly return the unopened cd package and all accompanying written 
materials to the place obtained for a refund. 
 
 
1. GRANT OF LICENSE.  This STC license agreement (“license”) permits you to use one copy of the STC software product (“software”) 
on any single computer, provided the software is “in use” on only one computer at any time.  You may have as many copies of the 
software in use as you have licenses. 
The software is “in use” in a computer when it is loaded into the temporary memory (i.e. RAM) or is installed into the permanent memory 
(e.g. Hard disk, or other storage device) of that computer; however a copy installed on a network server for the sole purpose of distribution 
to other computers is not “in use.” 
You must have a reasonable mechanism in place to assure that the number of persons using the software concurrently does not exceed 
the number of licenses.  If the software is permanently installed on the storage device of a computer (other than a network server), then 
the person authorized to use such computer may also use the software on a portable computer or home computer.  If such person’s 
authorization to use such computer ceases for any reason, then such person’s authority to use the software on the portable or home 
computer shall cease. 
 
2. COPYRIGHT.  The software is owned by STC or its suppliers and is protected by United States copyright laws.  Therefore you must 
treat the software like any copyrighted material (e.g. a book or musical recording) except that you may either (a) make one copy of the 
software for backup or archival purposes, or (b) transfer the software to a single hard disk provided you keep the original solely for backup 
or archival purposes.  You may not copy written material accompanying the software. 
 
3. OTHER RESTRICTIONS. You may not rent or lease the software, but you may transfer your rights under this license on a permanent 
basis provided you retain no copies and the recipient agrees to the terms of this license.   Any transfer must include the most recent 
update and all prior versions.   You may not reverse engineer, decompile or disassemble the software. 
 
4.  LIMITED WARRANTY.  STC programs are provided “as is” without any expressed or implied warranty of any kind, except that the disk 
will boot up within 90 days of purchase.  The entire risk as to the quality and performance of the programs is with you, the licensee.  
Should the programs prove defective, you assume the risk and liability for the entire cost of all necessary repair, service or correction.  
Some states do not allow the exclusion of implied warranties, so the above limitations may not apply to you.  This warranty gives you 
specific legal rights, and you may have other rights which vary from state to state as well.  
 
 5. LIMITATION OF REMEDIES.  STC’s entire liability and your exclusive remedy shall be replacement of any non-bootable cd at no 
charge. 
 
6.  NO LIABILITY FOR CONSEQUENTIAL DAMAGES.   In no event shall STC or its suppliers be liable for any damages whatsoever 
(including, without limitation, lost profits or revenue, loss of use of software, loss of data, or costs of recreating lost data).  Some states do 
not allow the exclusion or limitation of consequential damages, so the above limitation may not apply to you. 
 
7.  U.S. GOVERNMENT RESTRICTED RIGHTS.  The software and documentation are provided with RESTRICTED RIGHTS.  Use, 
duplication, or disclosure by the United States Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of The Rights in 
Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer 
Software – Restricted Rights at 48 CFR 52.227-19, as applicable.  Manufacturer is Service Technologies Corp./ P.O. Box 24756 / 
Winston-Salem, NC  27114-4756. 
 
8.  GOVERNING LAWS.   This agreement shall be governed by, and interpreted in accordance with, the laws of the State of North 
Carolina.    
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STC’s Windows System Manager - Overview 
 
STC’s Windows System Manager is a simple, external Windows-based interface offering 
secure access to our Windows products.  System Admin handles setup & access for Users, 
Companies & Menus.  It operates from “outside” the DOS or Windows-based Accounting 
Package whose files it processes.  Key Benefits to users are as follows: 

 
DOS-based Accounting System Users can put the powerful features of STC’s Pay-Ware 
& Utilities for Windows Programs to work with existing Systems.  No Accounting 
System upgrades are required! 
 
Accessing STC Programs from “outside” the accounting package does not “add” to 
that system’s active User Count.  For User-intensive features such as Counter Sales 
terminals, this may reduce the user-license count (and maintenance fees) needed to run 
the system day to day.  Additional STC Users @$295 are significantly less costly. 
 
Direct access from a smaller menu reduces the time & complexity needed to perform a 
specific task.  Users can “get in,” perform the desired activity and exit the job quickly 
without “clicking through” multiple menus 
 
Network Users can use the STC System Manager to “repath” Pay-Ware payroll data files 
outside the accounting system drive.  This can allow “ironclad” network-level file 
access security for this sensitive data. 

 
The System Manager Menu System is intuitively easy to use.  It is modeled after popular 
“Browser” formats with Program -Specific or Menu Group Categories shown down the left 
side and individual Menu Options on the right side. 
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STC System Manager 
 
 

STC’s Windows System Manager - Overview 
 
 

 
 
 

When installation is complete, the System Manager will install a new STC Utilities option on the 
“Programs” section of the Windows “Start” Menu (see above).  It will also install (at user’s option) a 
Desktop Icon/Shortcut to the program.  The Program may be launched from either option. 
 

 
 

After being launched, the System Manager Login Window will appear requesting the User Name and 
Password.  Entering this information launches the “blue” STC System Manager shown above.  
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System Configuration Requirements 
 

The STC System Manager requires a computer with the following equipment: 
Minimum Pentium 166 or higher CPU & 32Meg RAM - 8x CDROM drive  
Windows ’95 or later O/S  
Monitor capable of at least 800X600 display resolution. 
Laser Printer is highly recommended. 
 

 
Pre-Installation Checklist 

 

1. If Installing this STC Windows Program to run ONLY from within the PFW by Best® Menu system 
(without installing the STC System Manager) STOP! See STC’s separate Installation Guide. 

 
2. To install this STC Program including the STC Standalone System manager (for external program 

configuration & user access) follow the instructions in this guide.  
   

a. If access from BOTH PFW & STC System Menus is desired, the STC Program MUST be 
installed in the PFW Server & Client Directories.  PFW Administratative setup is required to 
properly handle Menu Item, User, & Company Access security under PFW. 

   
b. If access is ONLY from the STC System Manager, the program may be installed on any drive/ 

directory.  Network Users must install the Program Files on a Network Drive.  Note that Client 
files must be installed on a local drive.   

 
   Standalone installations MUST install Client files in a separate directory/folder from Program  
   Files.  

  
3.  Due to the complexity of installation, it is strongly recommended that an Authorized VAR or 

Consultant perform any STC Utility or Pay-Ware for Windows installation. 
 

 
Installation Overview 

 
STC Utilities for Windows installation procedure is a client/server installation. Any Windows-based programs 
should be closed and virus-detection programs disabled before installing. 
 
Please read through the entire procedure before starting any Installation activities  
 

1. Server/Program Files Installation – STC Utilities’ executable program files are installed from the CDROM to 
newly created subdirectory (X:\xxx\stc_util) on the network file server.  With PFW - Other PFW 
Resource/Menu files are updated and the STC Client Setup files are installed.  

 
2. Module User Setup – STC Utilities’ administrative functions (user access/security & Company Setups) are 

configured.  To run under PFW Menu, Menu access must be set up by the PFW System Administrator for 
existing and new users to ensure confidentiality. 

 
3. The individual Client Workstation set-ups are made from the Server’s Client Files 

 (Originating directory X:\xxx\stc_util\pwclient\setup.exe). 
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1. Installation Procedure – Network Server Files (Network Admin Rights required) 
 

This step does not need to be run on the actual file server.  You can perform this step from a workstation. 
 
• Identify the network Drive where Platinum for Windows system files are installed. 
 
• Insert the STC CD-ROM into the drive and close it. 

 
• Click the Start Menu & Select: “Run”. 

 
• Browse the CD Drive for the set-up.exe program.  Run it, and the routine will launch. 

 
The following Installation Window will appear-Read the Information and Proceed to the next window to select 
the utilities to install. 

 
 
 
Select which product to install. 
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When finished selecting the Program to install, Click ‘Next” and the set-up process for that Program will begin. 

STC Programs Installation Procedure 
 

The installation procedures for all of the STC Windows Programs are the same.  The steps outlined below will 
work for all of them. 
 
The following Installation Window will appear identifying the Program to be installed. Read the Information and 
proceed to the next window to review the licensing agreement. 
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Hit “Yes” to “Accept” the terms of the Licensing Agreement and to proceed with the installation.  
(Note that you may go back to the previous Window or Exit the set up program at any time.) 
 
This window is used to select which version of the program you want to install.  If you have purchased a live 
version, there will be a sticker on the CD envelope with your serial number. 
 

 
 
If you chose a Standard installation, the following Window will appear requesting User Name, Company 
Information and Product Serial number.  Be careful to enter all the characters (including dashes) in the serial 
number accurately. You will not be able to proceed without a valid serial number.  Note that the Demo Version 
may be installed without a Serial No. 

 

 
Hit “Next” button when information is entered. 
The next Window will appear requesting the Drive/Directory locations where the program is to be installed.  
Browse to change the default information.   Note, if this Program is to be accessed from the PFW Menu, it 
must be installed under the “Platinum System” folder on the server.  
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Hit “Next” to confirm the Drive and directory information.  Standalone Users:  If not installing under “Platinum,” 
we recommend that you install to an STCPROG Directory/Folder on the desired drive.   If this destination 
Folder does not exist, you will be prompted automatically to create it (see above).  Click Yes. 
 
This Window allows final confirmation of all information provided thus far. 
 

 
Hit “Next” button to confirm this information and begin copying files. 
 
When all files are copied to the Server and the PFW menu file has been updated with the new options the 
following message will appear.  Hit the “Finish” button to complete the Server installation.   

 
 
There is generally no need to reboot as a result of this install. 
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NOTE: The steps above will be repeated for each Program you install. 
 
 

  2.  Installation Procedure – STC System Administrative Set up  
  
 Skip this step if the Program is not being run from the PFW System Menu  

 
User & User Group Access/Setups - Once the STC Utilities system files are installed on the server, the  
System Administrator should log on and enable the new options for the eligible user groups. 

 
Crystal Viewer - STC Programs run on the workstation and reports can be output to Crystal Reports’ viewer or 
to Windows Laser Printers  To view the report again (without re-running it) it must be “saved” (to the Desktop is 
easiest) and opened in Crystal. Reports may also be printed to Windows’ printers after they are displayed in 
the Viewer.  .     
 
Printer Setups should be reviewed to verify they will work with the new options.  STC Programs print directly 
through Windows.  PFW–defined printer setups are not used.  Since Crystal is a graphical. page-based output 
interface designed for Laser printers, printing reports to Dot-Matrix printers will be significantly slower than 
under PFW and some formatting may be lost.   
 

 
3. Installation Procedure – STC Program Client Workstation Set Up 
   
After all STC Utilities server/system setups are done, the individual STC Client Workstation setups are run from 
the Server’s STC Client Set-up Folder (originating directory X:\xxx\stc_util\pwclient\setup.exe).  [Directory 
“xxx” would be STCPROG for the example from the previous page.] 
 
The installation procedure for the first 3 windows is the same as section 1 (above) except that the destination 
location folder on window 3 should be pointed to the workstation’s local Client Drive & Folder (generally c:\pfw 
for PFW users).   
 
For stand-alone/Local use, any Folder/Directory on the Local Workstation hard drive (We recommend 
C:\STCCLIENT) may be specified except for the directory where the Program files are installed (X:\STCPROG in 
the above example).  If the directory does not exist, the program will prompt you to automatically create it. 

 

 
When “Next” is clicked, the routine will then prompt whether to install the STC System Manager – Click Yes. 
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Users are then prompted to specify the appropriate Windows Program Menu Group where the Program will be 
“launched.”  Specifying the default will add an STC Utilities Group and Menu Item.  This means that when 
Windows Start>Programs are clicked there will be an “STC Utilities” option on that list of Programs. 
 

 
 
When Next is clicked, the verification window allows you to confirm the installation path for the STC client files. 
 

 
 
When Next is clicked, the installation will begin copying files from the “system/programs” folder down to the 
“client folder on the local drive. 
 
Once the files have been copied to the local PFW drive, click “Finish” to complete the installation.   After all 
Client Workstations are set up, software installation is complete. 
 
4. Verify Installation 
The final installation step is to inspect the Windows Programs Menu and the Desktop for the new STC 
Programs.  Each of these should be double clicked to verify that it launches the Login Window shown in the 
Overview section of this document.  If so, the installation has been successfully completed.    
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You must repeat this procedure for all Workstations accessing STC Programs. 
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5. Setup Procedure – STC System Manager Configuration-First Time Access 
       
     PC Administrator or Accounting Supervisory Personnel should perform these steps 
 
This is the final step before an STC Program can be run from the STC System Manager. 
 
Launch the STC System Manager by Double clicking the STC Program Menu item or the STC Desktop Icon to 
bring up the Login Window.  Someone with responsibility for PC Implementation/Supervisory responsibility next 
logs in as “Admin” with the Password “MASTER” (both of these are case-sensitive) to access the program 
configuration options.  

 

 
STC Login Window 

 
 
Once the STC System Manager loads, access Administrative Option by clicking “Admin” just below the blue 
Task Bar.  The first item to be configured is “User Group Setup.”   Note that no menu items may appear yet. 
  
 

 
STC System Manager Menu-Administrative Options 
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STC System Manager Configuration - (continued) 

 
 User Group Setup controls Menu Security allowing Administrators to customize Processing Menus by User 
Group.  The Menu Items visible to each User and their ability to process (or merely view the data available) on a 
Menu Item is determined by the User Group to which that User is assigned.  The “Default” user Group comes 
with the program.  The easiest way to load the Configuration Window is by double clicking the “Find Record” 
Lookup button & then clicking on Default Group in the lookup window. 
 

 
User Group Setup Window 

 
After the window builds, the list of all Menu Items will appear with a Read & Write Column of checkboxes.  
Each Menu Item that is checked “Write” will appear to every User assigned to the “Default” User Group.  They 
will be able to fully process all these items.   Menu Items checked “Read” will allow the User access to the 
information available on that Menu Item, but the user will not be allowed to change or process any of its data.  
Items that are not checked will not appear at all on the User Menu. 
 
Once the Default Group’s Menu is checked off, the change to the record must be “saved” by clicking the 
File>Save or the Diskette Icon (same as most windows programs), 
 
 
 
 
Open New Record 
 
 

 
  
 
“Cloning” a User Group (or any record) is quickly done by selecting an existing record (Group), which is 
setup similarly to the record to be added.  Once the record is loaded, click the “Edit>Set As Default” Menu 
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options and then the “New Record” Button.  Change the ID, Name and revise any other desired data.   Then 
“save” the newly named record. 
 
STC System Manager Configuration - (continued) 
 

Company Setup (accessed by clicking the Admin Menu) is the second Setup item to be configured.  
There are no defaults setup for this menu item.  New processing companies may be setup from “scratch” or the 
STC System Manager can be configured to access data from an existing Accounting System.  The window 
allows a Company Key & Company Name to be setup in fields 1 & 2.  These can be the same or different than 
the Key(s) & Name(s) specified for the same data in the Accounting System.   The data fields, which get 
processed, depend entirely on the data paths entered in Fields 3 & 4.  This feature can allow sensitive payroll 
data to be moved to a separate Network drive/directory for security reasons. 
 
Lookups and record “cloning” work just like those in User Group Setup.    
 

 
Company Setup Window 

 

User Setup – After User Groups and Companies have been setup, Users may be assigned to them.  
Clicking on the Admin Menu’s User Setup option loads the following configuration window.  
 

 
User Setup Window 

 
User IDs are entered in Field 1 and Password in Field 2 (leaving blank will allow user access without a 
password.  The user is assigned to the desired User Security Group and Processing Companies (see above) 
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in Fields 3 & 4.  Note the “Find Record lookup on the “User Key” field at the top of the window allows quick 
retrieval of all users’ configuration.   Lookups and record “cloning” work as previously described. 
 
When all Users have been setup, STC System Manager configuration is complete.       [End of Section]  
 STC Programs – User Processing Basics - File Maintenance/Data Entry 
 
Windows Processing Basics 
STC Programs processing windows are similar to those of most Windows Programs.  There is the familiar Blue 
Title Bar at the top Identifying the Window and its Max/Min/Close boxes.  
 
The basic Menu Row for File, Edit, View & Help functions is also familiar and many tasks associated with 
those operations (such as Save, Delete, Cut, Paste, etc.) are similar to most Windows-based programs.  
 

  Note that “right clicking” the mouse will launch a Cut, Copy, Paste Menu (found under the Edit Option).   
 

Other tasks are more program specific.  For example the File Menu contains all activities associated with 
accessing a record and moving through the database (Get First/Last/Next/Previous Record & Find, Save or 
Delete Record).  
 
The row of “Operator Buttons below the Menu Row is more unique to STC Products.  They largely provide a 
shortcut to the actions associated with the Menu Items above. But they should be familiar to any user of a 
Windows-based Accounting System.  These “Buttons” do the following (Right to Left). 
   

New Record         Erase/Delete Record 
          Save Record    Get 1st or Previous Record 
         Get Next or Last Record 
            Find Existing Record Button 

 
 
The Arrows & Double arrows allow users to “Step through” the available set of records frontward or backwards.  
The Find Record Lookup Button allows a quick way to find a specific record without stepping through them via 
the Arrows.  Almost every field within a maintenance, entry, or parameter window has an associated lookup. 
 
“Cloning” a record, allows users to quickly add a new item to the database, which is very similar to an 
existing item.  This is quickly done by loading an existing record, (which shares many parameters with the 
“new” one). Once the record is loaded, click the “Edit>Set As Default” Menu options and then the “New 
Record” Button.  Change the ID, Name and revise any other desired data.   Then “save” the newly named 
record. 
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STC Programs – User Processing Basics - Lookups 
 
Lookups contain the available information for entry in the field.  Data to be entered in the field is selected 
from the lookup dialog box.  A Field’s lookup is almost always displayed by choosing/clicking the lookup 
button or pressing F9.   With certain lookups, you can scroll through the available lookup information. 
 
 
Table or Field Lookups 
These lookups appear in a Window as a “Magnifying 
Glass” Icon to the right side of a field. 
Clicking the Icon will launch a small mult-Iine lookup 
window from which available information may be 
selected.   
     Table Lookups (“Find Record”) appear against a   
     Yellow background (generally found at the top of a   
     parameter window)  & will show all available data    
     fields for a given record when it is clicked.  [This  
     will populate all data fields on the window]. 
 
     Field Lookups show against a gray background   
     and return only the data to populate that data field  
 
 Include List lookups appear as a “Down Arrow” to 
the right of a field.  All available data options “drop 
down” when the arrow is clicked. 
 

 

Calendar Lookups appear as desk calendars on Date-Related fields and launch a calendar with the current date 
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STC Programs – User Processing Basics - Running Reports & Listings 
 
Reports & Listings are a key component of your STC Program.  This Program generates all its reports 
using Seagate® Software’s popular Crystal® Reports program.  Unless specified otherwise on the “Routing” 
Tab of a Report’s Setup Parameters, the report will automatically be displayed On-Screen in the Crystal Viewer 
when is completed.  From the Viewer, the report may be printed to Windows Printer, printed to a file or its data 
exported to a Spreadsheet.   Any report’s “Routing” parameters may specify output directly to a printer.  In this 
case, the report will not appear on-screen in the viewer.  
 
Note that Crystal is a graphical, page-based printing program intended for Laser-type printers.  While it 
generally will output to Dot-matrix printers, Users may encounter long report printing times and formatting 
glitches.  We strongly recommend using Laser-type printers if at all possible.  
 
It is easy to define and save standard report parameters against which Reports or Listings are routinely run.  
Any Report (or Listing) which has had a parameter configuration “saved” will appear in a View List (below).   

In reports where no parameters have been saved, the View List will be empty.   
 
A “pre-saved” report can quickly be run by highlighting it and 1) clicking its Name in the box or 2) clicking the 
Process button below the list.  If the pre-saved format includes data fields that need to be filled in (for a range 
of Dates, for example) the Parameter setup window will automatically load and the cursor will stop in the first 
Field where an entry is needed.  This field will show a “Pencil” icon to the right. An entry must be made in all 
empty fields (clearing every Icon) before the report will process. 
 
Note that pre-saved parameters include the output location for the report (e.g. a specific Windows printer),  
 
Setup Parameters for any saved report may then be viewed and Modified by clicking the Edit Button.  If 
changes are made, the modified configuration may then be resaved under the old name (or saved under a new 
name-which creates an additional report on the View List) by clicking the Save Button.  The Report is removed 
from the View List via the Delete Button. 
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STC Programs – User Processing Basics - Running Reports & Listings (cont’d) 
 
Choosing the New or Edit buttons will load the Report Parameter Setup Window where Reports are defined 
and (optionally) saved.   

Clicking “New” will load a “blank” parameter Setup window (no data entries in any field). 
Clicking “Edit” on a highlighted report in the View List will load all its setup parameters. 

 
The typical Setup procedure goes as follows: 
 
Parameters Tab 

1. Sort Order for the report is selected in the top Field 
2. One or more Ranges of available Data items to be included in the Report are specified. 
3. Often a Range of Dates parameter is specified for the Report 

Output Format (Detail, Summary, inclusion of Totals or Page-breaks, etc.) items are specified. 
4. Note the “Pencil” Icon (below left) setup on the first Date Field.  It is used when report parameters are 

setup to “require” an entry in specific field.   The “Pencil may be removed from a field by  
 

Clicking the Pencil Icon (top of window) while the cursor is 
parked on a field and “saving” that Report Parameter will 
prompt for an entry in that field next time the saved Report is 
processed.  Entering valid data and hitting the <Enter> Key 
clears the “placeholder” and launches the report.  Clicking 
the Pencil Icon again will remove the placeholder/prompt. 
 

 
Tab 1- Parameters 

 
 
 
 
 
 
 

Tab 2 - Routing 
 
 
Routing Tab (see above right) specifies where the report will be “sent”.  All reports are defaulted to the Crystal 
Reports Viewer but the setup may be sent directly to any Windows printer.  You may require this Tab to appear 
before any saved report is processed by checking the “Show this Tab before processing” box at the bottom.  
This makes it simple for the user to route a given report to the desired printer or to the viewer.  

 
 
Remember that Dot-Matrix Printers are not optimizable for Crystal output. 
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